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PREFACE 

The education sector of Pakistan has achieved a milestone by developing a text book for Fashion 

Design for the first time in its history. The book is developed and reviewed by some of the most 

experienced educationists who are serving in this field for more than a decade, keeping in mind 

the basic knowledge to be inculcated to the students of matriculation. The knowledge will lay a 

staunch foundation for them to further excel in this field. At the same time, modern day educational 

approaches have been adopted throughout its development process. The exercises are designed in 

a manner that will challenge them to critically analyse the knowledge and develop a creative mind 

set. Author has specifically tried to give special attention to the fact that all the theoretically 

imparted knowledge is utilized practically through several sets of exercises and practical 

assignments. The book will definitely empower individuals in this field and will pave way for 

further excellence. 

Executive Director  

National Vocational & Technical Training Commission 

(NAVTTC) 
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- 

DRAWING - II 

Did you ever 

listen the 

term 

‘Croquis’? 

Did you know 

the 

abbreviation of 

CAD? 

Did you know 

which Adobe is 

best for clothing 

design? 

Students Learning Outcomes 

After studying this unit students will be able to: 

 define the concept of still life compositions.

 explain the importance of elements and principles in drawing in laying out a composition.

 apply the elements and principles of drawing in laying out still life compositions.

 identify the use of different media and material to render the composition.

 identify the nature of selected media and materials (water color pencils, water colors,

poster colors, chart papers, water color sheets).

 apply the rendering techniques to draw the compositions.
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Drawing - II 

Still Life Composition 

When you are painting or drawing a 

still life scene, composition is 

everything. While technique and 

expertise are crucial, it’s the subject of a 

piece that draws the viewer in and 

makes them want to study your work. 

Do You Know? 

The tone effects on composition as well as color palette 
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Elements and Principles of Drawing in layout of a Compositions 

Elements of Drawing 

Elements of art are stylistic features that are included within an art piece to help the artist 

communicate. The seven most common elements include line, shape, texture, form, space, 

colour and value, with the additions of mark making, and materiality. When analyzing these 

intentionally utilized elements, the viewer is guided towards a deeper understanding of the 

work. 

1. Line

Lines are marks moving in a space between two points whereby a viewer can visualize the 

stroke movement, direction, and intention based on how the line is oriented. Lines describe an 

outline, capable of producing texture according to their length and curve. 

2. Shape

A shape is a two-dimensional design encased by lines to signify its height and width structure, and 

can have different values of color used within it to make it appear three-dimensional. In 

animation, shapes are used to give a character a distinct personality and features, with the 

animator manipulating the shapes to provide new life. 
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3. Form

Form is a three-dimensional object with volume of height, width and depth. These objects 

include cubes, spheres and cylinders. Form is often used when referring to physical works of art, 

like sculptures, as form is connected most closely with those three-dimensional works. 

4. Color

Color is an element consisting of hues, of which there are three properties: hue, Chroma or 

intensity, and value. Color is present when light strikes an object and it is reflected back into the 

eye, a reaction to a hue arising in the optic nerve. The first of the properties is hue, which is the 

distinguishable color, like red, blue or yellow. The next property is value, meaning the lightness 

or darkness of the hue. 

5. Texture

Texture is used to describe the surface quality of the work, referencing the types of lines the 

artist created. The surface quality can either be tactile (real) or strictly visual (implied). Tactile 

surface quality is mainly seen through three-dimensional works, like sculptures, as the viewer can 

see and/or feel the different textures present, while visual surface quality describes how the eye 

perceives the texture based on visual cues. 
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6. Value

The scale between dark (black) and light (white) values. Value refers to the degree of 

perceivable lightness of tones within an image. The element of value is compatible with the term 

luminosity, and can be "measured in various units designating electromagnetic radiation". The 

difference in values is often called contrast, and references the lightest (white) and darkest (black) 

tones of a work of art, with an infinite number of grey variants in between. While it is most relative 

to the greyscale, though, it is also exemplified within colored images. 

7. Space

Space refers to the perspective (distance between and around) and proportion (size) between 

shapes and objects and how their relationship with the foreground or background is perceived. 

There are different types of spaces an artist can achieve for different effect. Positive space 

refers to the areas of the work with a subject, while negative space is the space without a 

subject. Open and closed space coincides with three-dimensional art, like sculptures, where 

open spaces are empty, and closed spaces contain physical sculptural elements. 
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Principles of Drawing 

1. Balance

Can be Symmetrical or Asymmetrical. 

Symmetrical = dividing a composition into two equal halves with seemingly identical elements on 

each side. 

Asymmetrical = balance based upon a visual sense of equilibrium that can be felt more than it can 

be measured. There are no specific rules for asymmetrical balance except that of diversity 

2. Repetition/Rhythm

A repeating visual element (line, shape, pattern, texture, movement); a flowing and regular 

occurrence. A subcategory of repetition is pattern. 

Pattern – any compositionally repeated element or regular repetition of a design or single 

shape; pattern drawing sin commercial art may serve as models for commercial imitation. 

3. Focus/Emphasis/Dominance

The prime center of visual importance within a composition to which all other visual elements 

yield; it holds the viewer’s attention because of its attractive and dominant influence on its 

surroundings Rule of Thirds. 
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A compositional tool that makes use of the notion that the most interesting compositions are those 

in which the primary element is off center. Basically, take any frame of reference and divide it 

into thirds placing the elements of the composition on the lines in between. 

Visual Center – The visual center of any page is just slightly above and to the right of the actual 

(mathematical) center. This tends to be the natural placement of visual focus. 

4. Pattern

Pattern is the uniform repetition of any of the elements of art or any combination thereof. 

Anything can be turned into a pattern through repetition. Some classic patterns are spirals, 

grids, weaves. For examples of different pattern types see the Artlandia Glossary of Pattern 

Design. A popular drawing practice is Zentangles, in which an abstract or representational 

outline is divided into different areas, each of which contains a unique pattern. 

5. Movement

The best and most straight forward way to show movement in a work of art is to carefully study how 

things change when in motion. For example, how does a person change when walking versus 

standing still? Or, how does a person appear when running versus walking. By changing the balance 

point and posture of a person, the artist can convey a static standing figure or the movement of a 

person walking or running. 
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Activity 

 The movement is shown in the following drawing. Complete the drawing.
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6. Variety

The counterweight to harmony and create visual interest by slightly changing or using 

different elements together in a composition. It can be created with contrast, change, elaboration, 

or diversifying elements. With variety, it is important to consider how the elements are working 

together so that you still have harmony and unity within a composition. This image of different fruits 

and vegetables is an example of variety. 

Activity: 
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Do You Know? 

Many artist follow the golden ratio or golden 

spiral 

7. Contrast

As a principle of drawing, contrast refers to the arrangement of opposite elements and effects. For 

example, light and dark colours, smooth and rough textures, large and small shapes. Contrast 

can be used to create variety, visual interest, and drama in an artwork. 

Application of Elements and Principles in Still Life Drawing 

1. Vary the textures of the objects you choose. Texture can add just as much interest as shape,

color, and placement.

2. Consider the shapes, colors, and sizes of the pieces in your composition. You’ll want

3. To include a variety to provide contrast, particularly when it comes to your focal point.

4. You want contrast, but watch the patterns you’ve combined.

5. The placement of the elements in your composition can serve to direct the reader’s eye either

from element to element.

6. Employ the Rule of Thirds, dividing their scene into three roughly balanced sections, either

horizontally or vertically.

7. At least some of your pieces should overlap.

8. Negative space created by your objects. The shapes and shadows of your negative space should

be just as interesting as the positive space.

9. Playing with the angle from which the viewer sees your composition is a good way to add

interest

Guide line 

Inanimate objects such as fruit, flowers,  

food and everyday items are painted as the 

main focus of interest in still life 
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Pick three favorite objects (favorite fruit, veggie, or vase of flower 

etc. Place them in a table in a grouping any way you like. These should 

be right in front of where they can see them to draw or paint. 

 
 
 
 

Draw a still life with pencil shading. 

 
 

 
 

Step 1: In still life, you should start to draw the transparent 

wire frame forms with visible lines of construction. 
 
 
 
 
 
 

Step 2: When composing a still life, try to introduce the qualities 

that make an interesting arrangement its balances and contrasts of 

line, shape, tone, color, pattern, texture and form. 
 
 
 
 
 

Step 3: Now lightly sketch in the shapes of any shadows 

or reflections onto each object. 
 
 
 
 
 

 
Step 4: Add some basic tones are lightly applied to each object 

to help build up its three dimensional form. 
 

 
 
 
 
 

Step 5: This time you deepen their tone, increasing the 

contrast between the areas of dark and light. This will enhance 

the form of the objects and increase their impact. 
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Interesting Information 

Step 1: It is more practical to paint the objects in order from back to front, as 

it is technically easier to paint the edge of any object over the preceding one. 

Step 2: Each bottle, one light in tone and the other dark, is neatly under 

painted in a flat opaque color. 

Step 3: Similar light green tones are then built up in glazes emphasizing 

details on both bottles. 

Step 4: In this final stage, the brightest highlights are built up on both bottles 

using tints of local color mixed with white for added opacity. 

Step 5: The subtleties of transparency, opacity and reflection depicted in 

the bottles augment the strong visual elements at play in the still life.
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Do You Know? 

Acrylic paint uses a synthetic resin to bind pigments 

Oil Painting 

Oil painting is the process of painting with pigments with a medium of drying oil as the binder. 

Interesting Information 

Choose the Right Brush 

Media and Material 

Different Media and Material for Composition: 

Acrylic paint is water-based fast-drying paint widely used by artists. As 

it can be diluted with water and used thinly or thickly depending on how 

much water is added to it, Acrylic paint is waterproof once it has dried 
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Interesting Information 

Create a chart of 2 x 2 box and develop different strokes styles 

using different brushes using different mediums oil paint and acrylic 

paint 
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OIL PAINT: A thick paint made with ground 

pigment and a drying oil such as linseed oil, used 

chiefly by artists. 

Tool Box 

ACTIVITY 

Create surface with oil marbling technique 

WATER COLOR 

Artists' paint made with a water-soluble binder 

such as gum and thinned with water rather than 

oil, Observational study draw a flower in water 

color use A3 Scholar sheet with drawing board 

material required for painting water color 

brush, water color palate, and water container. 
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Do You Know? 

Poster paint can be used in the same way as 

acrylic paint 

Poster Paint: Poster color is a water-soluble paint consisting of a color mixed with a binder 

such as glue or gum to give it a dull finish. An example of poster color is tempera paint. 

Interesting Information 

ACTIVITY

Do You Know? 

The paint can be applied in various techniques such as wet on wet and wet on dry. 
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Select a picture it could be from 

nature and create color swatches in 

2 x 2 inch box. Like: see the given 

picture. 

Water Color Pencil 

Water color pencils are fully water soluble: Watercolor 

pencils are a unique medium for creating art. They 

combine drawing with painting in a manner that no other 

medium can replicate. 

Apply a wet paintbrush and create 

fabulous water color effects on any 

motif or pattern 

Understanding the Nature of Media and Material: Activity 1: Use of Poster Color 

First of all draw a basic picture of house or tree on scholar sheet with drawing pencil. You will 

need poster color and paint brush for this .Wet your brush first with water then dry it with a cloth, 

then take small amount of green colour, dip the point of the brush then smoothly paint it. 

Do You Know? 

WATER   COLOR   PENCILS   are 

similar to colored pencils but behave 

differently when water is added. 
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Guide Lines 

Remember the amount of water should be less first. 

After the paint is applied in the drawing, you should 

spread the colour with moderate amount of water. 

Don't let the paint to dry, spreading must be done 

immediately after the colour is applied. 

Activity 2: Use of Water Color 

There are a couple of basic ways to paint with watercolor. The wet-on-wet method is typically 

used for painting landscapes, simple skies, or soft watercolor washes. Required things are: 

1. Water Colors

2. Water Color Brushes

3. Water Color or Scholar Sheet

4. Masking Tape

5. Water Container

Wet On Wet 

1. Start by wetting your brush with plain water and

“painting” two rectangles.

2. Pick up moistened paint from your palette and add color

to your wet rectangle.

3. In your second rectangle, just add dabs of paint.

Do You Know? 

Remember that watercolors dry lighter than they look when they’re wet. 
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Dry Wash 

1. Use a large flat or round brush and an angled surface like a drafting table or easel on your

palette,

2. Mix a generous amount of water with your chosen pigment. You might want to practice on a

scrap of watercolor paper first.

3. Load your brush with as much paint as it’ll hold. Then, working quickly, make a steady,

controlled horizontal stroke along the top of the paper.

4. Another stroke just below the first one, overlapping with the bottom edge.

5. When you reach the bottom, blot your brush on a paper towel, then use the dry tip to carefully

pull up the excess paint along the bottom of the final stroke to avoid a darker bottom. Let your

paper dry completely at an angle before setting it down flat again.

Application of Rendering Techniques to Draw the Composition 

Activity: Draw still life composition using pencil and use pencil shading? The 

composition must consist of fruits and glass bottle? 

Important steps to be considered: 

1. Use scholar sheet in your drawing.

2. Use drawing pencils for your drawing.

3. At least two vegetables and two fruits should be in your composition.

Interesting Information 
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Activity: Blended shapes using wet on dry? Some practice with basic wet on dry techniques 

you can try combining some of the ideas above and paint some blended shapes. 

Important steps to consider: 

1. For water color task you are supposed to

use water color sheet or scholar sheet

2. Rounded point water color brushes of size

4&6

3. Water color in cake palate of Pelican

Company

4. Combine geometric shapes and

overlap them for interesting compositions.

Key Points 

understand Anatomy. Stylize to Optimize. 

illustrations tell stories through imagery. Differentiate Between Fabrics with Texture. 

consider the way in which culture and ethnic heritage may affect the types of hairstyles 

a figure could wear. 

understanding how objects exist within a space can only help you drawing them in an 

accurate way. 

Web Links 

https://www.adobe.com/creativecloud/illustration/discover/fashion-illustration.html 

https://www.shawacademy.com/blog/fashion-drawing-guide-with-template/ 

https://www.masterclass.com/articles/step-by-step-fashion-drawings-how-to-draw-a- fashion-figure-

in-10- steps#:~:text=Fashion%20drawings%20are%20the%20blueprint,movement%20lines 

%20for%20fabric%20draping. 

https://www.google.com/search?rlz=1C1BNSD_enPK996PK996&q=Fashion+drawi 

ng+book&sa=X&ved=2ahUKEwiO2o2o6ZX3AhWgg_0HHcWmCb8Q1QJ6BAhLE 

AE&biw=1024&bih=625 

https://www.adobe.com/creativecloud/illustration/discover/fashion-illustration.html
https://www.shawacademy.com/blog/fashion-drawing-guide-with-template/
https://www.masterclass.com/articles/step-by-step-fashion-drawings-how-to-draw-a-fashion-figure-in-10-steps#%3A%7E%3Atext%3DFashion%20drawings%20are%20the%20blueprint%2Cmovement%20lines%20for%20fabric%20draping
https://www.masterclass.com/articles/step-by-step-fashion-drawings-how-to-draw-a-fashion-figure-in-10-steps#%3A%7E%3Atext%3DFashion%20drawings%20are%20the%20blueprint%2Cmovement%20lines%20for%20fabric%20draping
https://www.masterclass.com/articles/step-by-step-fashion-drawings-how-to-draw-a-fashion-figure-in-10-steps#%3A%7E%3Atext%3DFashion%20drawings%20are%20the%20blueprint%2Cmovement%20lines%20for%20fabric%20draping
https://www.masterclass.com/articles/step-by-step-fashion-drawings-how-to-draw-a-fashion-figure-in-10-steps#%3A%7E%3Atext%3DFashion%20drawings%20are%20the%20blueprint%2Cmovement%20lines%20for%20fabric%20draping
https://www.masterclass.com/articles/step-by-step-fashion-drawings-how-to-draw-a-fashion-figure-in-10-steps#%3A%7E%3Atext%3DFashion%20drawings%20are%20the%20blueprint%2Cmovement%20lines%20for%20fabric%20draping
https://www.google.com/search?rlz=1C1BNSD_enPK996PK996&amp;q=Fashion%2Bdrawing%2Bbook&amp;sa=X&amp;ved=2ahUKEwiO2o2o6ZX3AhWgg_0HHcWmCb8Q1QJ6BAhLEAE&amp;biw=1024&amp;bih=625
https://www.google.com/search?rlz=1C1BNSD_enPK996PK996&amp;q=Fashion%2Bdrawing%2Bbook&amp;sa=X&amp;ved=2ahUKEwiO2o2o6ZX3AhWgg_0HHcWmCb8Q1QJ6BAhLEAE&amp;biw=1024&amp;bih=625
https://www.google.com/search?rlz=1C1BNSD_enPK996PK996&amp;q=Fashion%2Bdrawing%2Bbook&amp;sa=X&amp;ved=2ahUKEwiO2o2o6ZX3AhWgg_0HHcWmCb8Q1QJ6BAhLEAE&amp;biw=1024&amp;bih=625
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Tick (√) the suitable option 

1. Two-Dimensional Design are Called?

a) Values b) Shape c) Foam d) Art

2. __________ is used to describe the surface quality of the work

a) Shape b) Foam c) Texture d) Balance

3. The difference in values is often called

a) Contras b) Values c) Colors d) Space

4. _____________is the uniform repetition of any of the elements of art or any

combination thereof 

a) Shape b) Pattern c) Foam d) Shading

5. As  a  principle  of  drawing,  elements and effects 

a) Varity b) Contras c) Movement d) Focus

6.  is water-based fast-drying paint widely used by artists 

a) Oil Paints b) Acrylic Paints c) Poster Paints d) Water Colors

7. The method is typically used for painting landscapes, simple skies, or 

soft watercolor washes

a) Dry on wet b) Wet on Wet c) Dry Brush d) Oil Based

8. are stylistic features that are included within an art piece to help the 

artist communicate 

a) Principle of Art

b) Elements of Art

c) Still life Drawing

d) Paintings

Exercise 
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9. describe an outline, capable of producing texture according to their 

length and curve 

a) Shape b) Line c) Foam d) Colors

10.  is three Dimensional Object 

a) Foam b) Line c) Shading d) Space

Write Short Answer of the following questions. 

1. What is drawing?

2. How many Elements in Drawing?

3. What is Color and which is its Properties?

4. How many types of spaces and how artist can achieve different effects?

5. What is Principle of Drawing? Write their name?

6. Difference between symmetrical and A- symmetrical?

7. How to create Movements in paintings?

8. What is Oil Painting?

9. What is Wet on Wet technique?

10. What is Pattern? Define pattern?

Answer the following questions in detail. 

1. What is drawing? How many elements of drawing?  Describe elements of drawing in

short with diagram?

2. Describe the principle of drawing with example?

3. Define the different techniques of paintings with materials?
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Did you ever do 

Brainstorming before 

starting any project? 

Did you know the 

difference 

between primary 

and secondary 

research boards? 

Students Learning Outcomes

Did you know 

the difference 

between 

primary and 

secondary 

research 

boards? 

After studying this unit students will be able to: 

 define the concept of Brainstorming

 identify the process of Theme selection with the help of brainstorming

 apply the process of theme selection

 describe the importance of research in Design development process

 explain  the  research  methodology  (Primary  and  secondary  research)Recognize

Research board, Theme board, Mood board and Colour board

 apply research methodologies to create Research board, Theme board, Mood board

and Colour board

 explain the process of developing designs with reference to Research board, Theme

board, Mood board and Colour board

 identify the design development process for creating final garment designs

 apply design development process to creating final garment designs

FASHION DESIGNING    GRADE X 
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Design Development for Fashion 

The process of design development is long and can be tiring as well. However we cannot deny 

its importance because quality of your design depends upon how carefully you have executed 

this process. Each step of this process has a significance. To start up with your work it allows 

you to clearly understand what you have to work on and who you are working for. In the end 

you find yourself to achieve your goals. In 

fashion design, if you are designing a 

garment, it is pre-requisite to know this 

process where you have to select a theme, 

research about it and develop its designs until 

you produce the final product. 

Interesting Information 

Design is defined to build an initial 

plan or drawing to know the function 

or working of an object. Design in the 

point form where the ideas, basic 

shapes could be objectified. 

Selection of Theme 

Concept of Brain Storming 

Brain storming is a method by which one could share the ideas and knowledge to resolve the 

problems. Brainstorming is the process of thinking new ideas. This can be done single handedly 

as well as in a group. It is a very useful tool that helps to deeply explore a topic that might has 

not crossed your mind otherwise. At the same time it this thinking process greatly enhances the 

creativity that ultimately helps in producing a good end product. 

Method of Brainstorming 

Start 

Ideas 

Generation 
Ideas 

Combination 

Evaluation & 

Validation 

Generate new 

ideas 
Selection of 

best Ideas 
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Process of Theme Selection 

In its literal meaning, a theme is the topic or subject that you choose to work on. For a fashion 

designer selecting a theme is of prior importance before you actually start working on your 

project. Brainstorming is the first step in selecting a theme after which you need to carry out a 

thorough research to ultimately select a topic of your choice. 

Research 

1. Define Customer

Think about who your customer is. Try to develop an image of what your customer looks like, 

their attitude, their accessories, and their hair. 

2. Define Market

This includes identifying the brands which sell to your customer and doing research on what 

they charge and what the buying habits of their customers (your customers) are. Visit stores, look 

on the internet, do everything you can to be familiar with the market you want to design for. There 

are several groups of markets. For your first collection, if you are doing this only as a learning 

exercise and do not plan to market the clothing/product to people you may choose to skip this. 
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Every designer should understand the market they are designing for. However for someone who 

is attempting this the very first time and just wants to design this may be overwhelming or too 

boring. 

3. Perform Trend Research

This step is important depending on your market. Every market has different trends, so be 

aware of what trends affect your market. Do not forget to learn about the past. A designer who 

designs for a trendy market is able to predict upcoming trends, especially colours, will find 

success. Designers who do not do trend research may work in an area where trends are not as 

important however that designer will not be successful without awareness of what his/her customers 

are currently wearing. This may be just rote knowledge gained from reading the magazines or 

it may come as a specific research task. 

4. Inspiration

Decide what your inspiration is for this final product/design and develop a mood board or concept 

board using images, drawings, paint, fabric, twigs, anything that says to you what this final 

design means. Sometimes a designer is inspired by fabric or by a set of fabrics. Even though 

they have their colour palette from the fabrics and they have their fabrics it is important for 

most to still define their inspiration by finding images which give the mood that they envisioned 

when they became inspired by that fabric. An inspiration collage is a collection of inspiring images 

to use to work from. 

After going through all this process the designer should be able to finalize a theme for his work. It is 

important to keep in mind that you should have detailed information about it. This would greatly 

help you to keep going with the project smoothly throughout the developmental process. 
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Activity: 

Do a brainstorming exercise on the topic of “spring” 

You must add pictures and drawings to support your ideas. 

Development of Research Board and Mood Board. 

After the selection of theme the next important step is the development of research board and 

mood board. These are so important tools that at many stages of developmental process you will 

have to get back to them. 

Importance of Research 

Research in a process in which one investigates systematically, in order to establish facts 

thorough research in design development provides insight into the latest design trends, consumer 

buying patterns, and competitor strategies. It gives the designer two types of insight. The first is a 

sense of action, which leads to empathy for the consumer. Secondly, understanding behavior 

will provide the design process with clues about patterns and practices. It involves identifying the 

touch points between the consumer and the product. Conducting research demands that you are 

comfortable with ambiguity during the early stages of a project in order to finally achieve clarity. 

Research plays an important role in design development process. It helps us to understand the 
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methodology of design development. It gives the validate design direction through qualitative and 

quantitative research methods. 

Research Methodology 

Research  methodology  is  a  technique  used  to  identify,  select  and  gather,  analyzed 

information about topic. 

Types of Research 

 Primary Research

 Secondary Research

Primary Research (Related to Theme Images) 

Primary research is any type of research that you 

go out and collect manually. Examples include 

surveys, interviews, observations, and 

ethnographic research. A good researcher knows 

how to use both primary and secondary sources in 

her writing and to integrate them in a solid 

fashion. 

Conducting primary research is a useful skill to obtain as it can greatly supplement your 

research in secondary sources, such 

as journals, magazines, or books. 

You can also use it as the focus of 

your writing project. Primary 

research is an excellent skill to 

learn as 

it can be useful in a variety of 

settings including business, 

personal, and academic. 
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Secondary Research (Related to Theme Images) 

Secondary sources are  the findings 

of other people. These may be found 

in books, the Internet, journals,    and   

magazines. They are just as important 

as primary sources of research  

and often allow you to see and read 

about things that are no longer 

around  or  are  not easily accessible. 

It is vital that you understand both 

types of sources and that in any good 

research there is a balance of both. Primary sources will call upon your drawing talents and 

secondary will utilize your investigative skills. So be prepared to bring both together in your 

design research. 

Activity: 

Make research board keeping in a mind the topic 

of “Spring”. 

Advantages Of Primary Research Advantages Of Secondary Research 

Greater control 

Retention information 

Skillful information 

Time saving accendibility 

Enhancing perspective 

Cost effective 
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Research Board 

The research board, deals with planned research methods. It is an initial step before making a 

design. One collects different information regarding to a given topic from different sources. 
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Mood Board 

A mood board is a tool used by designers to help them get a good idea of what their clients are 

looking for. Mood boards are basically collages of items such as photographs, sketches, 

clippings, fabric swatches and color samples. A mood board can be actual or virtual. A mood 

board is used by many different types of designers such as those in fashion and interior design. 

They may be physical or digital, and can be "extremely effective" presentation tools. In short, 

mood boards are not limited to visual subjects, but serve as a visual tool to quickly inform 

others of the overall "feel" (or "flow") of an idea. Mood boards are also very useful at the early 

stages of a project as a guide tool to show to clients for approval before proceeding further” 

Activity: 

Develop a colored mood board on A3 card board sheet. 

Material 
1. Card board

2. Scissors

3. Ruler

4. Uhu

5. Pencil

Color Board 

Different shades of primary or secondary colors are placed together to create a color board and 

tries different elements together by making final garments. 
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Story Board 

“A story board is a summary of your collection’s inspiration and theme. It’s a design tool that 

will  help  you  remain  focused  and  consistent  as  your  line  develops.  It’s  also  a  great 

communication aid when explaining your vision to others (retailers, media etc.). Magazine 

tears, fabric swatches, old photos, buttons, ribbons; basically any visual reference you desire 

are mounted onto a hard board. Be sure to give your story board a title, like a book or film” 

Storyboard should include the following: 

 A fashion figure, clothed in your designs on a flat working figure

 Swatches of your fabric (all the fabrics used)

 Colour palettes (all the colours that are used in your designs)

 Any trims used

 Photographs of the garments

Garment Design 
Fabric Selection Rendered Sketches 

Colour Palette 

Activity: 

Keeping in mind the topic spring develop story board keeping in mind the following  points. 

1. Sustainable fashion

2. Elements of design

3. Principals of design
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Development of Garment Design 

Development of garment design covers all the design elements, including texture, space, color, 

pattern, lines, silhouette, proportion, shapes, focal point and balance. All these objectives make a 

garment physiological comfort towards a visual perception. 

Process of Developing Design. 

In design process one has to gathers materials for 

developing for final garments silhouette colors with 

the help of mood board, color board, theme board 

and research board. 

Process of Design Development for Creating Final Garment Design 

There are nine steps involved in the design process, which are given below. 

a. Mood board (inspiration board)

b. Fashion illustration

c. Technique sketches

d. Tech pack

e. Sampling

f. Sourcing

g. Review

h. Design approval

i. Production

Steps of fashion design process are given below. 

1. Detecting inspiration

2. Selecting colors

3. Choosing fabrics

4. Sketches

5. Consider silhouette

6. Prototyping

7. Sampling

Interesting Information 

While developing mood board keep in 

mind following 4 things: 

1. Your own art

2. Art from other artist

3. Photocopy from books

4. Inspiring quotes
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Key Points 

brainstorming is the starting point of design development process. 

brainstorming may include text, pictures, drawings etc. 

after the selection of theme it is important to carry out thorough research. The 

research that the designer does himself is called primary research. 

the research that is already done about a certain topic is called secondary 

research. 

a mood board provides a good visual representation. 

a story board is the summary of your developmental process. 

Web Links 

https://textilelearner.net/fabric-embellishment-techniques/ 

https://www.masterclass.com/articles/inside-the-fashion-design-process-from- 

briefs-to-assembly#how-the-fashion-design-process-works 

https://www.google.com/search?q=Design+development+for+fashion+excercise&o 

q=Design+development+for+fashion+excercise&aqs=chrome..69i57j33i10i160j33i 

21j33i22i29i30l7.21562j0j15&sourceid=chrome&ie=UTF-8 

https://www.google.com/search?q=development+of+garment+designing&rlz=1C1 

BNSD_enPK996PK996&ei=T5ReYoeSNJCPxc8PhKyw- 

AY&oq=Development+of+Garment+Design&gs_lcp=Cgdnd3Mtd2l6EAEYATIIC 

CEQFhAdEB4yCAghEBYQHRAeMggIIRAWEB0QHjIICCEQFhAdEB4yCAghE 

BYQHRAeMggIIRAWEB0QHkoECEEYAEoECEYYAFAAWPYMYLduaAFwA 

XgAgAG-AogBvgKSAQMzLTGYAQCgAQGgAQKwAQDAAQE&sclient=gws- wiz 

https://textilelearner.net/fabric-embellishment-techniques/
https://www.masterclass.com/articles/inside-the-fashion-design-process-from-briefs-to-assembly#how-the-fashion-design-process-works
https://www.masterclass.com/articles/inside-the-fashion-design-process-from-briefs-to-assembly#how-the-fashion-design-process-works
https://www.google.com/search?q=Design%2Bdevelopment%2Bfor%2Bfashion%2Bexcercise&amp;oq=Design%2Bdevelopment%2Bfor%2Bfashion%2Bexcercise&amp;aqs=chrome..69i57j33i10i160j33i21j33i22i29i30l7.21562j0j15&amp;sourceid=chrome&amp;ie=UTF-8
https://www.google.com/search?q=Design%2Bdevelopment%2Bfor%2Bfashion%2Bexcercise&amp;oq=Design%2Bdevelopment%2Bfor%2Bfashion%2Bexcercise&amp;aqs=chrome..69i57j33i10i160j33i21j33i22i29i30l7.21562j0j15&amp;sourceid=chrome&amp;ie=UTF-8
https://www.google.com/search?q=Design%2Bdevelopment%2Bfor%2Bfashion%2Bexcercise&amp;oq=Design%2Bdevelopment%2Bfor%2Bfashion%2Bexcercise&amp;aqs=chrome..69i57j33i10i160j33i21j33i22i29i30l7.21562j0j15&amp;sourceid=chrome&amp;ie=UTF-8
https://www.google.com/search?q=development%2Bof%2Bgarment%2Bdesigning&amp;rlz=1C1BNSD_enPK996PK996&amp;ei=T5ReYoeSNJCPxc8PhKyw-AY&amp;oq=Development%2Bof%2BGarment%2BDesign&amp;gs_lcp=Cgdnd3Mtd2l6EAEYATIICCEQFhAdEB4yCAghEBYQHRAeMggIIRAWEB0QHjIICCEQFhAdEB4yCAghEBYQHRAeMggIIRAWEB0QHkoECEEYAEoECEYYAFAAWPYMYLduaAFwAXgAgAG-AogBvgKSAQMzLTGYAQCgAQGgAQKwAQDAAQE&amp;sclient=gws-wiz
https://www.google.com/search?q=development%2Bof%2Bgarment%2Bdesigning&amp;rlz=1C1BNSD_enPK996PK996&amp;ei=T5ReYoeSNJCPxc8PhKyw-AY&amp;oq=Development%2Bof%2BGarment%2BDesign&amp;gs_lcp=Cgdnd3Mtd2l6EAEYATIICCEQFhAdEB4yCAghEBYQHRAeMggIIRAWEB0QHjIICCEQFhAdEB4yCAghEBYQHRAeMggIIRAWEB0QHkoECEEYAEoECEYYAFAAWPYMYLduaAFwAXgAgAG-AogBvgKSAQMzLTGYAQCgAQGgAQKwAQDAAQE&amp;sclient=gws-wiz
https://www.google.com/search?q=development%2Bof%2Bgarment%2Bdesigning&amp;rlz=1C1BNSD_enPK996PK996&amp;ei=T5ReYoeSNJCPxc8PhKyw-AY&amp;oq=Development%2Bof%2BGarment%2BDesign&amp;gs_lcp=Cgdnd3Mtd2l6EAEYATIICCEQFhAdEB4yCAghEBYQHRAeMggIIRAWEB0QHjIICCEQFhAdEB4yCAghEBYQHRAeMggIIRAWEB0QHkoECEEYAEoECEYYAFAAWPYMYLduaAFwAXgAgAG-AogBvgKSAQMzLTGYAQCgAQGgAQKwAQDAAQE&amp;sclient=gws-wiz
https://www.google.com/search?q=development%2Bof%2Bgarment%2Bdesigning&amp;rlz=1C1BNSD_enPK996PK996&amp;ei=T5ReYoeSNJCPxc8PhKyw-AY&amp;oq=Development%2Bof%2BGarment%2BDesign&amp;gs_lcp=Cgdnd3Mtd2l6EAEYATIICCEQFhAdEB4yCAghEBYQHRAeMggIIRAWEB0QHjIICCEQFhAdEB4yCAghEBYQHRAeMggIIRAWEB0QHkoECEEYAEoECEYYAFAAWPYMYLduaAFwAXgAgAG-AogBvgKSAQMzLTGYAQCgAQGgAQKwAQDAAQE&amp;sclient=gws-wiz
https://www.google.com/search?q=development%2Bof%2Bgarment%2Bdesigning&amp;rlz=1C1BNSD_enPK996PK996&amp;ei=T5ReYoeSNJCPxc8PhKyw-AY&amp;oq=Development%2Bof%2BGarment%2BDesign&amp;gs_lcp=Cgdnd3Mtd2l6EAEYATIICCEQFhAdEB4yCAghEBYQHRAeMggIIRAWEB0QHjIICCEQFhAdEB4yCAghEBYQHRAeMggIIRAWEB0QHkoECEEYAEoECEYYAFAAWPYMYLduaAFwAXgAgAG-AogBvgKSAQMzLTGYAQCgAQGgAQKwAQDAAQE&amp;sclient=gws-wiz
https://www.google.com/search?q=development%2Bof%2Bgarment%2Bdesigning&amp;rlz=1C1BNSD_enPK996PK996&amp;ei=T5ReYoeSNJCPxc8PhKyw-AY&amp;oq=Development%2Bof%2BGarment%2BDesign&amp;gs_lcp=Cgdnd3Mtd2l6EAEYATIICCEQFhAdEB4yCAghEBYQHRAeMggIIRAWEB0QHjIICCEQFhAdEB4yCAghEBYQHRAeMggIIRAWEB0QHkoECEEYAEoECEYYAFAAWPYMYLduaAFwAXgAgAG-AogBvgKSAQMzLTGYAQCgAQGgAQKwAQDAAQE&amp;sclient=gws-wiz
https://www.google.com/search?q=development%2Bof%2Bgarment%2Bdesigning&amp;rlz=1C1BNSD_enPK996PK996&amp;ei=T5ReYoeSNJCPxc8PhKyw-AY&amp;oq=Development%2Bof%2BGarment%2BDesign&amp;gs_lcp=Cgdnd3Mtd2l6EAEYATIICCEQFhAdEB4yCAghEBYQHRAeMggIIRAWEB0QHjIICCEQFhAdEB4yCAghEBYQHRAeMggIIRAWEB0QHkoECEEYAEoECEYYAFAAWPYMYLduaAFwAXgAgAG-AogBvgKSAQMzLTGYAQCgAQGgAQKwAQDAAQE&amp;sclient=gws-wiz
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 Tick (√) t he Suitable Option 

1. Brainstorming is the process of thinking:

a) New ideas

b) Renewed idea

c) Experimental ideas

d) Old ideas

2. Theme means

a) Name b) Subject c) Object d) Work

3. After theme selection one needs to develop

a) Colour board

b) Story board

c) Mood board

d) Research board

4. Mood board is an effective tool for

a) Presentation

b) Observation

c) Interview

d) Survey

5. The research that you do yourself is called

a) Tertiary research

b) Secondary research

c) Primary research

d) Ordinary research

6. A story board is the summary of your

a) Fashion drawing

b) Theme

c) Work

d) Idea

7. A colour board helps to determine

a) Design

b) Size

c) Silhouette

d) Colour scheme

8. Type of research that is already done is called

a) Basic research

b) Primary research

c) Secondary research

d) Tertiary research

Give Short Answers to the following questions. 

1. What is primary research?

2. What is the importance of a mood board?

3. What do you know about brainstorming?

4. What is the importance of research in the process of design development?

Exercise 
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5. What is a research board?

Answer the following question in detail. 

1. What is research? Explain in detail.

2. What is the difference between primary and secondary research?

3. Explain story board as an important element for garment development.

Constructed Response Question 

Match the key words to the definition. 

Key Word Answers 
Definition 

Brainstorming a) The research that is already being done

Primary  research 
b) summary of the collection

Secondary research 
c) visual representation of ideas

Mood board d) collection of ideas

Story board e) the research done by the designer himself
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Final Project 

 If you are using magazine, pick any 3 interesting details from a dress that you loved.
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Have you ever 

noticed dress 

designs are made 

on fashion? 

Did you ever 

listen the term 

‘croquet’? 

Do you know the 

difference between 

technical drawing 

and Fashion? 

Students Learning Outcomes 

After studying this unit students will be able to: 

 explain about the Illustration of stylised fashion figure/Croquis

 recognize the process of drawing 9Head stylised fashion figure/Croquis

 recognize the process of drawing10 Head stylized fashion figure/Croquis

 apply the process of drawing 9Head and 10 Head stylised fashion figure/Croquis

 identify the different variations of garment component.

o sleeves (Simple Sleeve and Sleeve with Cuff)

o collars (Band Collar and Two Piece Collar)

o necklines (Round Neckline and V-Shape Neckline)

 identify the technical drawings/sketches of garment components:

o sleeves (Simple Sleeve and Sleeve with Cuff)

o collars (Band Collar and Two Piece Collar)

o necklines (Round Neckline and V-Shape Neckline)

 interpret complete garment in the terms of technical drawing
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Fashion Drawing - II 
 

 
 

Stylised Fashion Croquis/Illustration A 

fashion figure is different than a regular figure drawing 

in the fact that it is a more dramatic, less detailed 

representation featuring more exaggerated movement 

and proportions. Fashion figures can essentially take 

any shape you desire stylistically allowing you to really 

express your style artistically. Often times, the style of 

your fashion sketches reflects the style of the clothing you 

are designing. As a beginner, don't stress too much about 

finding your style right away- this is something that 

occurs naturally over time whether you strive for it or 

not. For now, focus on learning the basic proportion and 

movement concepts described below which should 

hopefully lay out the bullring blocks for finding your drawing style over time. 

A good fashion drawing should be able to capture the movement of the design and fabric you are 

envisioning. If you learn a few basic concepts about proportion, balance and movement you'll 

be able to sketch a fashion figure in just a few minutes. 
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Croquis 

In fashion, the term refers to a quick 

sketch of a figure (typically nine heads 

tall as this is the accepted proportions 

for fashion illustration) with a loose 

drawing of the clothes that are being 

designed. Often a large number of 

croquis drawings will be created for 

one finished look, which is fully drawn 

and finished. 

The Process of Drawing 9 Heads Stylised Fashion Figure 

By the term stylization is understood the exaggeration of the structure of the body, reducing it to 

a few essential features. There are various ways of stylizing a figure, and one of them is to 

elongate the height of the model by one or two units of measure. 

First Method 

As you will see in the two diagrams, the 

proportions have remained unchanged in every 

instance, that is to say that the anatomy of the 

figure has remained the same while the length of the 

limbs and principal parts of the body has been 

modified. 

 The diagram above has been elongated by one

and a half units of measure and the one on the

page opposite has been raised by two.

 The  head  has  more  or  less  the  same

https://en.wikipedia.org/wiki/Fashion
https://en.wikipedia.org/wiki/Fashion_illustration
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dimensions, the shoulders are slightly broader in 

relation to the pelvis, and the neck has been slightly 

elongated. The chest has also been broadened while the 

pelvic region has been shortened. 

 The waist has been reduced in size, the limbs have been

elongated, maintaining proportions with the upper

body. The feet obviously follow the extension of the

body in length.

Second Method 

 In the 2nd method the pose has been rendered even more abstract, reducing the figure to a few

essential lines which exaggerate the structure.

 The resulting drawing is very similar to the outline but presents more energy and vitality.

Movement can also help the viewer understand what 

makes up the clothing you’re drawing or painting. 
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Third Method 

Another system for obtaining a convincing fashion plate is that 

of reducing a real figure without making it any taller, leaving 

almost unaltered its basic proportions. 

 The diagram clearly shows the variations that have been 

introduced. The waist has been made thinner as well as 

the flank, the pubic region has been raised, the legs and 

arms are equally long but have been made thinner, and the 

neck is slimmer, while the head and the feet remain 

unchanged from their original size. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Using this technique of 

multiple poses with a fixed 

upper body, you will obtain 

various fashion plates from 

a few basic original 

positions. 
 
 
 
 
 
 
 
 
 

 

Do You Know? 

 
From clothes to accessories, fashion illustrations have a long history as a visual reference  

for a designer’s concepts or current fashion trends. 
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Application Process of Drawing Basic 9 Head and 10 Head Stylised Fashion 

Figure 

1. Draw a subtly curved vertical line in one

continuous movement. Don't worry about

how straight or how curved the line is, just

free-hand a vertical line. This will serve as

your vertical balance line. Vertical balance

line is a straight line that determines figure

balance and foot placement. This semi- 

curved line will still allow drawing the 

correct balance in a fashion figure but it will 

also help to capture the figure's movement 

much easier. 

2. Next, draw a slanted horizontal line less than

half the distance down from the top of the vertical

line as displayed in the image.

3. From the horizontal line you just drew (the

hip line) divide the top portion of the

vertical line in 3 parts. Draw dash lines to

help you visualize the division better. The

first part from the hip line up should be

approximately the same length as the upper

most part of the vertical line. The middle

portion should be slightly longer than the

two outer parts described.
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4. On the first dash from the top draw

another horizontal slanted line in the opposite 

direction to the hip line. This will serve as the 

shoulder line. 

4. Move down to the next dash (right in the middle)

and sketch a smaller horizontal line that is just a

little bit slanted in the same direction as the hip line-

This will mark

the waist line.

6. Now to connect the dots portion: You will

connect the shoulders to the waist, the waist to

the hips and the hips to the bottom center dash

on both side of the figure. This will complete a

rough draft of the torso and you will finally

start to see your fashion figure emerge from all

the lines.
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7. Starting at the side hip, draw a 

semi-curved line (with the curve 

opening down) to the edge of the 

lower most dash line (crotch line). 

Repeat this step on both sides of the 

hips. 
 

 
 
 
 
 
 
 
 
 
 

8. Draw straight or slightly curved lines 

starting at the underwear line down to the 

area of the knee placement. The 

direction of the leg should be pointing 

away from the vertical balance line. 
 

 

Draw the lower part of the leg by bringing 

the leg orientation straight, parallel in 

relation to the vertical center line. 
 

 
 
 
 
 
 

9. When the figure is standing straight, the elbows will be 

aligned with the waist and the wrist will be aligned to 

the hip line. 

 
When the hips and shoulders change with movement, the 

wrists and the elbows will change with it. 

Using very soft curved lines, draw the arms from 

shoulder to elbow making sure the elbow stops at the 

waist area in accordance with the concept described 

above. Next, use softly curved continuous lines to draw 

the forearm starting at the elbow to the wrist ensuring 

that the wrist ends at the hip area. 
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10. When it comes to drawing a fashion

figure, it's not really about drawing

the feet as much as it is drawing

shoes. Just like the hands, you do

not need to worry about detailed

drawings but rather a few general

variations of foot placement and

perspective views.

11. Try a few hand gestures with your

fashion figure. Keep in mind that it will

take a few tries to get the right size in

relation to the rest of the body. If you

are concerned about size, it is always a

better idea to go a bit longer than

shorter- this could work stylistically

and provide a more dramatic style in

your fashion drawing.

12. Draw the general shape of the head using more squared lines for the jaw area. Divide

the face in 4 equal parts using a horizontal and vertical dash line. Sketch the eyebrows using

the eye placement as a guide. Add a dash line to mark the nose at about half the distance

down from the eyes to the chin. Using a simple dash line for the nose is sufficient to give

your fashion figure a finished look.  Try to visualize the movement of the hairstyle and

capture it in your drawing using a few simple lines. Add more lines where the hair is fuller.
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Components of Outfit/Garment 

Different Variations of Garment Component 

1. Sleeves

Simple Sleeve 

Sleeve is a part of the upper garment. It is attached to bodice at the 

armhole. Sleeves add grace and beauty to any garment. Sleeves can 

be modified to suit wearers figure. There are different types of 

sleeves. Some are close fitting and others are stitched with fullness. 

The length of sleeve can be changed to create short, elbow sleeve, 

three forth sleeve and full sleeves. Colour, texture, shape and size of 

sleeves can also be changed to create sleeve variations. Sleeves are 

generally cut along straight grain, but to create variation, it can be cut 

on cross grain also. 

Sleeve with Cuff 

A sleeve cuff is a finish given to the sleeve at the hem – It is an 

extra layer of fabric added to the sleeve edge. Normally the 

sleeve hem has a simple turned edge hem. But when you want 

something different you can try one of these beautiful cuffs. 

 Shirt Cuff

 Barrel Cuff/ Single Cuff

 Double Cuff/ French Cuff

2. Collars

Band Collar 

A band collar is a standing band-shaped collar that encircles the neck 

without a full turndown or a collar "cape". It can be any height or 

"stand", but is usually under 2" at the front, so as not to push up 

into the chin. Variations of the band collar are the clerical collar, 

the mandarin collar and the cadet collar. 
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Band Collar 

The two-piece shirt collar is constructed of two different collars: 

the bottom part - the band - which is basically the Mandarin Collar 

with an extension to the value of the button placket, and the top 

part is the Turnover Collar, but with a different shape to the collar 

points. 

Follow the instructions in Mandarin/Turnover Collar pages to  

draft the two-piece collar, taking into account the minor 

modifications needed which are explained below.  The 

modifications are: 

 Inch extension to the Mandarin Collar

 Shape of the neck edge of the Turnover Collar

3. Necklines

Round Neckline 

The crew-neck is also known as the round neck. A basic, 

simple neckline that suits many different body shapes and is 

one of the most common types of necklines. A crew-neck 

minimizes the amount of chest showing and this gives the idea 

of a shorter neck and fuller chest area. 

This is a very universal complimentary neckline. It has the 

ability to lengthen a shorter neckline and balance broad 

shoulders. It draws the eye inwards and places less emphasis 

on a wide torso. 

A variation of the v-neckline, the cut-out V, has slits cut out of 

the side of the V-neck and this adds to the variety and 

individuality of the neckline. 
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Technical Drawing/Sketches of Garments Component 

Different Variations of Garment Component 

1. Sleeves

Simple Sleeve

Sleeve with Cuff 

2. Collars

Band Collar
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Two Piece Collar 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Neckline 
 

Round Neckline 
 
 
 
 
 
 
 
 
 
 
 
 
 












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V-Shape Neckline 

Interpret Complete Garment in the Term of Technical Drawing 
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Key Points 
 

a fashion sketch is the first step in bringing your fashion creations to life. Fashion 

illustration is the art of drawing, sketching, or painting fashion concepts and 

design ideas used to visualise a garment before it’s produced. Fashion 

illustration is more stylistic. 

fashion drawing is how to create a 9-head figure, draw your garment design on 

the figure, and rendering that design to portray a certain textile, texture, and 

print. 

on women’s garments, the right side laps over the left; on men’s, the left side 

laps over the right. 

shaping materials are layers of fabric used inside the garment shell that maintain 

the form of the garment by adding stability, strength, smoothness, and support 

in key areas. 

each garment pattern needs to have the style number, the name of the part, the 

balance mark, and the construction lines. The successive step can be to digitise 

it to turn the draft into a computer-aided design CAD/CAM. 

 
 

Web Links 
 

https://textilelearner.net/viva-questions-and-answers-for-fashion-design-students- and-

professionals/ 

https://www.seniorcare2share.com/how-to-draw-a-fashion-figure-with-pictures/ 

https://www.kenyaplex.com/questionpapers/166-fashion-design-and-sketching.aspx 

https://quizizz.com/admin/quiz/60c3a9bb88da7c001f1bc3ba/fashion-sketching 

 

 
  

https://textilelearner.net/viva-questions-and-answers-for-fashion-design-students-and-professionals/
https://textilelearner.net/viva-questions-and-answers-for-fashion-design-students-and-professionals/
https://textilelearner.net/viva-questions-and-answers-for-fashion-design-students-and-professionals/
https://www.seniorcare2share.com/how-to-draw-a-fashion-figure-with-pictures/
https://www.kenyaplex.com/questionpapers/166-fashion-design-and-sketching.aspx
https://quizizz.com/admin/quiz/60c3a9bb88da7c001f1bc3ba/fashion-sketching
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 Tick (√) t he Suitable Option 

1. —————————-is more than just clothing.

a) Apparel b) Garment c) Clothing d) Fashion

2. ————————-is a general term referring to actual objects related to the

human body.

a) Costume. b) Wardrobe. c) Clothing. d) Wear ability.

3. ———————–is the process of transforming a design in to its constituent flat

pattern pieces and then drafting then out.

a) Pattern making. b) Draping. c) Template d) Blocks

4. ———————– is a high neck line that cuts straight across the collar bone.

a) Jewel b) Cowl neck c) Scoop d) Boat neck

5. 4. A sleeve cut wide at the armhole and tapering to the wrist is—————— 

a) Dolman sleeve.

b) Puff sleeve.

c) Plain sleeve.

d) Tulip sleeve

6. This is defined as the designer’s way of communicating ideas about style, fashion,

and fit of clothing in a visual form through drawings and painting.

a) Fashion Croquis

b) Fashion Drawing

c) Fashion Template

d) Fashion Sketching

Give Short Answer to the following questions. 

1. Describe the material of fashion drawing?

2. How do you draw a fashion figure face?

3. How many heads is a fashion figure?

4. What is Components of Outfit/ Garment?

EXERCISE 
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5. Write the name of five sleeves?

6. Write down the names of four tools used for cloth cutting?

Answer the following questions in detail. 

1. Draw the ladies figure and make dress shaded with pencil.

2. Write the introduction of basic figure drawing.

3. How do you draw fashion design?

4. How do you design an outfit?

5. What is Stylized Fashion Illustration?

Final Project: 

You have been requested to design a range of ladies' outfits consisting of dresses, blouses, 

jackets, skirts and trousers. 

Make a design development sheet of TWO of each of the following garments: jacket, blouse, 

trouser, skirt and dress. Keep ALL requirements in mind for a good design development 

sheet. 
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- 

CAD for Fashion Designing 

Did you ever 

listen the 

term 

‘Croquets’? 

Did you 

know the 

abbreviation 

of CAD? 

Did you know 

which Adobe is 

best for clothing 

design? 

Students Learning Outcomes

After studying this unit students must be able to: 
 describe the basic concept of CAD.

 explain the importance of CAD in Fashion Industry.

 identify the basics of Adobe Photoshop.

 evaluate working on Channels/Layers.

 evaluate the use of basic Tools of Adobe Photoshop.

 experiment and use different shapes using basic tools.

 define the procedure to import file/images in Adobe Photoshop.

 explain the process of developing Mood board/Research board using Adobe

Photoshop tools.

 use tracing tools to create basic motif.

 explain the basics of fashion illustration.

 recognize the process of making basic fashion Croquis.

 use basic tools for colouring Fashion Croquis.

 define the procedure to draw the garment in Adobe Photoshop.

 interpret the procedure to draw the garment on Croquis in Adobe Photoshop.

 use basic tools to create and colour a garment on fashion Croquis.

 apply the procedure to draw the garment on Croquis in Adobe Photoshop.
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CAD for Fashion Designing 

Basic Concept of CAD 

CAD (Computer Aided Design) is the use of computer software to design and document a 

product's design process. Drawing entails the use of graphical symbols such as points, lines, 

curves, planes and shapes. Essentially, it gives detailed description about any component in a 

graphical form. 

Interesting Information 

Using CAD software, a fashion designer can create new sketches, patterns, prints more quickly 

and precisely. With the increasing use of CAD, fashion designers can create multiple variations 

of a single design and style and adapt it to varying material and pattern. 

Importance of CAD in Fashion Industry 

CAD is an important industrial art extensively used in many applications, including automotive, 

shipbuilding, and aerospace industries, industrial and architectural design, prosthetics, and many 
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more. CAD is also widely used to produce computer animation for special effects in movies, 

advertising and technical manuals, often called DCC digital content creation. 

Importance, CAD has been a major driving force for research in computational geometry, 

computer graphics (both hardware and software), and discrete differential geometry. 

The link between Computers & Fashion Designing has developed and evolved over the 

decades with the changing time, taste and pace of fashion and style. And when we talk about 

Fashion and application of computers in the fashion industry, we cannot imagine the smooth 

functioning of it without the use of CAD Software. And nowadays, we are seeing the link 

between fashion design and CAD is growing stronger and deeper. The knowledge of CAD 

software is essential for an aspiring Fashion Designer entering the Fashion industry and even for 

an established fashion designer within the Fashion Industry. So, before we jump into 

understanding how CAD is so important in Fashion Designing for a Fashion Designer as well as 

Fashion Design Institutes let us understand what exactly is CAD. 
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Benefits of Computer Aided Design in Fashion Industry

 Using CAD software, a fashion

designer can create new sketches,

patterns, prints more quickly and

precisely. With the increasing use of

CAD, fashion designers can create

multiple variations of a single design

and style and adapt it to varying

material and  Pattern.

 CAD also allows the fashion designer

to explore various color-ways of a

print developed as opposed to the

traditional design methods; the alterations and rectifications are

 quick as well as more accurate, as it reduces room for errors.

 As the whole process from print development, collection development can be done on

virtual version and very less part of the whole process is an actual physical raw material the

cost of collection development in fashion designing can be reduced to a minimum.

Point to Ponder! 

1. A Streamlined Design Process. When a designer is working with CAD, they can take

advantage of the way the software smooths out bumps in the design process.

2. Better Quality Design.

3. Simplify Communication.

4. Plenty of Documentation.

5. A Manufacturing Database.

6. Design Data Saved.

Do You Know? 

Computer-aided designers in the fashion industry use computer software to create sketches 

and other designs used to create clothes, accessories, shoes, intimate apparel, and more. 

Computer-aided design or “CAD” is fast becoming the future of sketching in the fashion 

industry.
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Basics of Adobe Photoshop 

Adobe Photoshop is the predominant photo editing and manipulation software on the market. Its 

uses range from the full-featured editing of large batches of photos to creating intricate digital 

paintings and drawings that mimic those done by hand. 

Interesting Information 

-- Non-Destructive Editing in Photoshop. -- Discover Adjustment Layers. 

-- Instant Automatic Photo Fixes. -- Make Your Photos Pop with Levels. ... 

-- Clean Up Shots with the Spot Healing Brush. -- Remove Unwanted Objects from Your Photos. 

Opening Files 

Most of the time, you'll want to start by opening an existing photo rather than creating a new blank 

image. Photoshop allows you to open and edit existing image files, including JPEG, PNG, and 

PSD (Photoshop document) files. 

To open a file 

 Select File > Open.

 A dialog box will appear. Locate and select the file on your computer, then

 click Open.

 The file will appear in Photoshop.
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Working with Tools and other Panels. 

The Tools panel, where you'll 

select different tools for editing 

images, is one of the most 

important features in Photoshop. 

Once you've chosen a tool, you'll be 

able to use it with the current file. 

Your cursor will change to reflect the 

currently selected tool. 

You  can  also  click  and  hold  to 

select a different tool. For 

example, you can click and hold 

the Rectangle tool to select 

different Shape tools, like the Ellipse Tool, Line Tool, and Custom Shape Tool. 

Working on Channels/Layers 

 What is a Layer?

A layer is simply one image stacked on top of another 

 Layers Panel

Photoshop’s layers Panel is a powerful tool that allows you to do many special things to your 

layer compositions. Next, we will look at the Photoshop layers palette. 
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 Layer Filter: This enables you to hide layers

based on different things. Makes it easier to

find the layers that you want to work with.

 Opacity: 0= transparent 100 = fully opaque.

press number keys on the keyboard to

instantly set to multiples of 10, or adjust the

slider for an exact amount of transparency on

each layer.

 Blend Modes: Change these to change the

way that the selected layer blends with the

layers underneath it. Great for compositing

and special effects. (With the move tool

selected, press Shift+ or Shift- to cycle

through blending modes.

 Fill Opacity: Adjusts the amount of opacity of the pixels only, but any layer styles are

unaffected and remain 100% opaque.

 Visibility: If the eye is showing that layer is visible. Click on the eye and the layer will still be

there but invisible until you click on the eye again.

 Locked: The padlock means that something is locked in the layer. (Also click on the 4 icons in

the “lock” next to fill opacity to make certain things editable or locked).

 Lock all: If the box is checked the layer is totally protected from any editing.

 Position: You can make any changes except for moving the image.

 Lock Image Pixels: You cannot draw on this layer if checked.

 Lock Transparent: You can paint on this layer but not where it is transparent.

Useful Tools at the Bottom of the Panel 

 Link: Enabled you to link layers. These will all move together unless unlinked.

 Layer Effects (Styles): Special effects applied to your image layer. Noted by the little f.
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Each effect will be listed. Multiple effects may be 

used at once. 

 Add Layer Mask: This is the button to press to add

a layer mask to the currently selected layer.

Allows you to paint away parts of your layer

without damaging your original image.

 Add Adjustment Layer: The best way to apply

image adjustments. They can change the color or

tone of an image. All layers are affected underneath

an adjustment layer (Unless clipped). This is a good

option to use

 Image>Adjustments because adjustment layers are

non-destructive and re-editable.

 Layer Groups: A good organizational tool. This

puts layers into a folder. You can choose multiple layers  and press Cmd/

 Ctrl+G to put them in a group, or create a group by clicking this Icon. Layers can be  dragged

in or out of groups in the Layers panel.

 Create New Layer: Press this icon to create a new layer. Drag an existing layer into this icon

to create a duplicate of that layer.

 Delete Layer: Drag a layer into this icon to remove it. Or select the layer and then press this icon

to get the same result.

 Panel Options: This will open a drop-down menu that provides a number of options, many

that aren’t listed anywhere else.

Types of Layers 

In Photoshop there are a number of different types of layers. They  re usually indicated by icons, 

here is what they all do. 

 Thumbnail: A small picture of the layer’s contents.

 Layer Group: This puts layers into a folder. Layers can be dragged in or out of groups in the

Layers panel.
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 Type Layer: The same as an image layer, except this layer

contains type that can be edited; (Change character, color, font

or size)

 Adjustment Layer: An adjustment layer is changing the color

or tone of all the layers underneath it. To only affect the layer

directly underneath it (an ignore the other underlying layers):

Move your pointer on the line between the adjustment layer

and the layer directly beneath it, hold down Alt/Option. You

will see a symbol appear. Click to limit the adjustment. (Clip

to layer) do the same thing again to toggle this option off.

 Layer Style: An effect has been applied. Click the eye to turn it

on or off. Double click “effects” to open the Layer Styles

options.

 Layer Mask: Allows you to paint on the mask to show and

reveal portions of the image.

 Smart Object: A special type of layer that is actually a container

that can hold; multiple (or 1) layers, vectors for illustrator, raw

files, video, 3D or many other types of objects.

Basic Tools of Adobe Photoshop 

Photoshop's toolbar is located along the left of the screen. 

Choosing a Single or Double Column Toolbar 

By default, the toolbar appears as a long, single column. But it can 

be expanded into a shorter, double column by clicking the double 

arrows at the top. Click the double arrows again to return to a single 

column toolbar: 

The Tools Layout 

Let's look at how Photoshop's toolbar is organized. While it may 

seem like the tools are listed randomly, there's actually a logical 
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order to it, with related tools grouped together. 

At the top, we have Photoshop's Move and Selection tools. And directly below them are the Crop 

and Slice tools. Below that are the Measurement tools, followed by Photoshop's many 

Retouching and Painting tools. Next are the Drawing and Type tools. And finally, we have the 

Navigation tools at the bottom: 

Move and Selection Tools: 

Move Tool * (V) 

The Move Tool is used to move layers, selections and guides within a Photoshop 

document. Enable "Auto-Select" to automatically select the layer or group you 

click on. 

Art board Tool (V) 

The  Art  Board  Tool  allows  you  to  easily  design  multiple  webs  or  UX  (user 

experience) layouts for different devices or screen sizes. 

Rectangular Marquee Tool * (M) 

The Rectangular Marquee Tool draws rectangular selection outlines. Press and hold 

Shift as you drag to draw a square selection. 

Elliptical Marquee Tool (M) 

The Elliptical Marquee Tool draws elliptical selection outlines. Press and hold Shift to 

draw a selection in a perfect circle. 

Single Row Marquee Tool 

The Single Row Marquee Tool in Photoshop selects a single row of pixels in the 

image from left to right. 
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Single Column Marquee Tool 

Use the Single Column Marquee Tool to select a single column of pixels from top to 

bottom. 

Lasso Tool * (L) 

With the Lasso Tool, you can draw a freeform selection outline around an object. 

Polygonal Lasso Tool (L) 

Click  around  an  object  with  the  Polygonal  Lasso  Tool  to  surround  it  with  a 

polygonal, straight-edged selection outline. 

Magnetic Lasso Tool (L) 

The Magnetic Lasso Tool snaps the selection outline to the edges of the object as 

you move your mouse cursor around it. 

Object Selection Tool * (W) 

The Object Selection Tool lets you select an object just by dragging a rough 

selection outline around it. 

Quick Selection Tool (W) 

The Quick Selection Tool lets you easily select an object simply by painting over it 

with  a  brush.  Enable  "Auto-Enhance"  in  the  Options  Bar  for  better  quality 

selections. 

Magic Wand Tool (W) 

Photoshop's Magic Wand Tool selects areas of similar color with a single click. The 

"Tolerance" value in the Options Bar sets the range of colors that will be 

selected. 
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Experiment and use of Different Shapes using Basic Tools 

 Creating Motif Using Adobe Photoshop
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Procedure to Import File/Images in Photoshop 

Open Photoshop on your PC or Mac. It’s in the All-

Apps area of the Start menu in Windows, and the 

Applications folder in mac OS. Use this method if you 

want to import a single image into your Photoshop 

project. 

1. Open the file you want to work on. To do this, click the

File menu, select Open, and then double-click the

file. To create a new file, Press Ctrl+N(Windows)

or ⌘Cmd+N (Mac), name the file, then click OK

2. Click the New Layer icon. It’s near the bottom-right

corner of the Layers panel. It looks like a square

sheet of paper with an upturned corner. This creates

a new layer.

3. Click the File menu. It’s at the top-left corner of the screen.

4. Click Place…. It is near the center of the menu. This opens your computer’s file browser. 

This may be called Place Embedded in some versions of Photoshop. 

5. Select the image you want to import and click Place.

6. The checkmark. It’s at the top of the screen. The image is now placed on the new layer.

Point to Ponder! 

1. Set the direction of your project.

2. Collect existing material.

3. Add inspiring imagery.

4. Add examples of motion & sound.

5. Add color, fonts & files.

6. Transform your board from messy to organised.

7. Remain open to inspiration, wherever you are.

8. Explain your thinking.
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The Process of Developing Mood Board/ Research Board using Adobe 

Photoshop Tools: 

Mood Board 

A mood board, sometimes called an inspiration board, is a tool to help your visual ideas at the start 

of a creative project. It is a collage of images, material samples, color palettes and sometimes 

descriptive words and typography that will guide you in your work. 

Uses of Mood boards 

Mood Boards are used by a variety of creative 

professionals, including graphic designers, interior 

decorators, set designers, fashion designers, 

photographers, and event planners. Basically, anyone 

who is developing an object or environment that needs 

to have a particular “look” often starts with a mood 

board to specify design elements and color schemes. 

Reasons to Make Mood board 

A mood board has two main purposes: 

1. It helps you refine your ideas. Perhaps you are starting from a blank slate and you want to find

inspiration. Perhaps you already have a strong idea but want to affirm to yourself that it comes

together as you imagine and guide yourself through the many creative decisions ahead. In

either case, a mood board will give you the clarity you need before you start buying materials

or building elements.

2. It helps you communicate your ideas to others. Usually, a creative professional like a graphic

or interior designer will build a mood board to present their ideas to a client. From there, the

client will probably give feedback about the suitability of the overall idea or the strength of

certain items on the mood board over others. They might even choose between multiple

mood boards the designer has used to present different options. A layperson planning their

own event or design project won’t have clients, but they will probably also need to

communicate their ideas to someone else at some point a contractor, collaborator or, if it’s a

wedding, their fiancé/e.
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The Process of developing Mood Board 
 

Step 1: Let's start by creating a new document with the following size: 1080 x 1080 px. 

Step 2:  Now press Control-R to activate the Guides and drag a Guide to each side of the 

document. 
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Step 3: Add four more guides indented by ten pixels from each side. 

Step 4: And finally, add two more guides to the center of your document. 

How to Make a Mood Board in Photoshop 

Step 1: Now, we are ready to start creating our mood board template. Press U and create a 

rectangle with the following size: 600 x 600 px. Move it to the upper left corner of the 

document while Holding Shift. 
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Step 2: Create another rectangle with a size of 445 by 600 px and place it in the right upper 

corner. 



FASHION DESIGNING    GRADE X 

75 

Step 3: For the third shape, we'll use a rectangle with a size of 600 by 325 px. Once you've 

created it, move it to the left guide and 18 px down from our first shape. 

Step 4: Let's create the last shape for our photos. Make a rectangle with a size of 445 by 325 px 

and move it to the right guide, indented by 18 px from the top shape. 
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Step 5: Now, we can add our photos to the template. Just go to File > Place and select the photo 

you want to use. 

 

 

 

 

 

 

 

 

 

 

Step 6: Put the photo above one of the shapes in the Layers panel and Right Click > Create a 

Clipping Mask. 
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Step 7: To re-size the image so that it will fit the shape, we need 

to hit Control-T and resize it while holding Shift. 

Step 8: Add three more photos, as we did before. And now you know 

how to make a mood board in Photoshop! 

How to Make a Photo Collage Palette 

Step 1: Now, let’s add a color palette to our mood board Photoshop 

template! Create a rectangle with a size of 252 by 84 px and put it on the 

left guide, indented by 15 px from the bottom guide. 

Step 2: Create three duplicates of the shape by pressing Control-J, and 

then move the shapes 18 px from one another. 

Step 3: Double-click on the first palette shape in the Layers panel, and 

then select Color Overlay and select one of the main colors from your 

photo with the color picker. 

Step 4: Add color overlays to the other shapes, just as we did before. 

Here is our final result! Now you know how to create a mood board in Photoshop using 

rectangle shapes and guides. While working with mood boards, you could reverse the process: 

try to start by creating the color palette with the colors you prefer, and then find some photos that 

suit this color palette. The Pantone 

colors of the year could be a great 

choice for creating a base for your 

palette. Feel free to share your results in 

the comments below. 
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Basic Fashion Croquis using Adobe Photoshop 

What is a Fashion Croquis? 

In fashion, a Croquis is a quick sketch of an 

ensemble. The fashion model figure is 

exaggerated with elongated legs, arms, and 

neck. The average human body is about seven 

heads tall, but Croquis often span from eight 

to eleven heads tall. 

Is Adobe Photoshop Good for Fashion Designers? 

When combined with Illustrator, Adobe Photoshop adds to the versatility of your fashion 

design projects, allowing you to work with various bitmap images as well as imported 

Illustrator images. 

Basics of Fashion Illustration 

Fashion illustrations are found in magazines, promotional ads, and boutiques as stand-alone 

pieces of artwork. Alternatively, technical sketches called flats are used by fashion designers to 

convey the idea of a design to a patternmaker or fabricator. “Technical design sketches in the 

fashion industry usually stick to strict guidelines, but the beauty of illustration is that fashion 

artists are free to make figure drawings and digital art that are much more creative. 

Point to Ponder! 

 Understand body proportions. To get started with fashion drawing, you need to

understand body anatomy.

 Define your character poses. Once you have the body proportions clear, practice

sketching different poses.

 Place the clothes.

 Explore and find your style.
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The Process of making basic Fashion Croquis 
 
To make Fashion Croquis required Tools are: 
 

1. Pen Tool 
 

2. Line Segment 
 

3. Shape Tool 
 
 
Start with a Straight Line 
 

Draw a vertical line across your page to represent 

the span of your figure from head to toe. 

 
 

Divide Figure into Equal Sections 
 

Evenly mark along the line so it’s divided into 

sections. Since the first section will be the length 

of the head, the other sections are referred to as 

“heads” too. If it’s your first time drawing a 

Croquis, make your figure ten heads tall. It’s an 

even number that’s easy to divide into smaller sections. 

Proportion the Figure 
 

Decide how long the torso, arms, and legs should be. “The first section right on top is the head. Then 

the next is the neck. The torso is about two to three sections. The pelvis is one. And the rest of the 

sections are the legs and feet. This gives your Croquis model a tall, elegant look. 

 

Draw Lines for the Shoulders and Hips 
 

Add in horizontal lines for the angles of the shoulders, chest, waist, and hips. For a cute pose, draw 

the shoulder line and chest line angled one way, and the neck and head angled the other. This is 

your time to refer to your reference drawings and experiment with different dynamic poses. 

 

Fill in the full figure 
 

Once you have the angles in place, sketch in the full form of your model. Add curves to the hips 

and waist and flesh out the legs and arms. The hands should hit between the pelvis and mid- 

thigh. Sketch fingers on the hands and add the curves of the elbows and knees. 
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Basic Tools for Coloring Croquis 
 

The basic tools to color a Croquis are 

as follow: 

 

 Brush Tool: 

 

The Brush tool paint the current 

foreground color on an image. The 

Brush tool creates soft strokes of 

color. 

 Paint Bucket Tool: 

 

The Bucket Tool will select the path you want to fill the color. Once you choose the Color, drop 

it to the selected path. Duplicate the layer   and   keep   repeating   the 

process until you get the desired Image. 

Illustration of Basic Croquis with Garment 

Procedure to Draw Garment in Adobe Photoshop 
 

 Create a new Photoshop Document 

 

Choose File > New to create a document. 

 

Note: If you intend to have your pattern 

printed as a textile, choose a manageable 

dimension for a tile, such as 4 x 4 inches, and 

set the Resolution to 300 pixels / inch. 

Choose CMYK color for the Color Mode and 

press OK. 

Start by finding an interesting image that 

would work as a repeating pattern. 

Copy and paste or File > Place the chosen 

image onto the canvas. 
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Procedure to Draw the Garment on Croquis in Adobe Photoshop 

 Cut Out Part of the Image

Click the Quick Selection tool in your toolbar and drag 

over the area of the image you want to cut out. Hold down 

the Option/Alt key to subtract from your selection. 

Choose Select > Refine Edge and manipulate the Adjust 

Edge controls to clean up your selection. Click OK. 

Finally, click Add Layer Mask in the Layers panel to 

isolate the selection from the rest of the image and make the 

background transparent. 

Basic Tools to Create and Color a Garment on Fashion Croquis 

1. Adjust colors and apply filters

Choose Layer >New 

Adjustment Layer > 

Hue/Saturation, and then click 

OK. Adjust the settings in the 

Hue/Saturation panel to 

brighten the colors. 

You can also apply other 

adjustments to get the effect 

you want. For instance, you 

can apply the Filter > Pixelate > 

Mosaic to get a pixelated look. Make sure you select the image thumbnail in the Layers panel before 

applying filters. 

Tip: Leah achieved her pixelated effect by duplicating the image layer and applying the Mosaic 

filter. Then, she masked out parts of the pixelated layer to reveal the original beneath it. 

2. Save artwork to Creative Cloud Library

Now that you have artwork, you can save it as a graphic to your Creative Cloud Libraries and use 
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it in Illustrator to create a pattern. 

Choose Windows > Library. Then Select all visible layers in your Layers panel. In the Libraries 

panel, click Add Graphic. A new graphic thumbnail appears in your library. 

Tip: Repeat steps 2-5 any number of times to create a wide variety of graphics to use in your 

pattern. 

3. Get Assets for Textile Design

To recreate the textile designs in this tutorial, copy the 

Pixel pattern library to Creative Cloud Libraries. Click 

Save to Creative Cloud to create a copy of the files in your 

own account. 

Once in your Creative Cloud Libraries, you can use these 

assets as patterns and images in your documents in 

Illustrator or Photoshop. 

4. Create a pattern in Illustrator

Launch Illustrator and create a new document with the same 

specifications you used in Step 1 (4x4, 300 ppi). Click Advanced 

and ensure the color mode is set to CMYK. 

Choose Window > Libraries and choose either your default 

library or the Pixel pattern library. Select the graphic thumbnail 

you created and drag it onto the art board. 

Click the Embed button in the Control panel at the top of the screen 

to add your artwork to the document. 

Several objects from your library to compose a pattern tile, rotating and 

scaling graphics as needed. 

When you're happy with your tile, select all the graphics in your 

art board and choose Object > 

Pattern > Make. The Pattern options dialog opens 

and a new pattern swatch is automatically added to the Swatches panel. 
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5. Set Pattern Options 
 

In the Pattern Options dialog, give your pattern a name 

and experiment with Tile Type settings. Change the 

Overlap setting to see what kind of affects you can create. 

Click Done. Your changes are applied to the new pattern 

in the Swatches panel. 

 

6. Use Pattern in an Illustration  

Now that you have a textile, you're ready to apply it to 

a fashion sketch or Croquis. You can create your own 

Croquis and scan it into Illustrator, or you can use the 

one in the Pixel pattern library. 

Start by creating a new art board. Click the art board 

tool in the toolbar. 

Click new art board in the Control panel. Place the new art board on your canvas far away from your 

tile. Click the Presets menu in the Control panel and choose Tabloid. 

Press Esc to exit the Art board tool. 
 

 

Draw the Garment on Croquis in Adobe Photoshop: 

In the Libraries panel, scroll to the Graphics section. 

Select the Croquis thumbnail, hold Option, and drag it 

onto the new art board. This allows you to place an 

editable version of the graphic. Click in the open space 

of the art board to deselect the entire Croquis, and then 

click just its garment. Click the Fill option in the 

Swatches panel then click the new pattern you just 

created. 

Create a Whole Collection 
 

Experiment with other textiles and Croquis to create your own 

fashion collection. 
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Key Points 

CAD (Computer Aided Design) is the use of computer software to design and 

document a product's design process. 

The link between fashion design and CAD is growing stronger and deeper. 

The knowledge of CAD software is essential for an aspiring Fashion Designer 

entering the Fashion industry and even for an established fashion designer 

within the Fashion Industry. 

CAD   allows the fashion designer to explore various color-ways of a print 

developed as opposed to the traditional design methods 

Photoshop allows you to open and edit existing image files, including JPEG, 

PNG, and PSD (Photoshop document) files. 

You can also click and hold to select a different tool. 

Layers Panel is a powerful tool that allows you to do many special things to 

your layer compositions. 

A mood board is called an inspiration board, is a tool to help your visual ideas 

at the start of a creative project. 

Web Links 

https://www.masterclass.com/articles/what-is-a-croquis-learn-how-to-draw-croquis- 

with-detailed-step-by-step-guide#quiz-0 

https://www.fashiondesignacademy.co.uk/blog/fashion-sketches-for-beginners 

https://textilelearner.net/computer-aided-fashion-designing/ 

https://www.masterclass.com/articles/what-is-a-croquis-learn-how-to-draw-croquis-with-detailed-step-by-step-guide#quiz-0
https://www.masterclass.com/articles/what-is-a-croquis-learn-how-to-draw-croquis-with-detailed-step-by-step-guide#quiz-0
https://www.fashiondesignacademy.co.uk/blog/fashion-sketches-for-beginners
https://textilelearner.net/computer-aided-fashion-designing/
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Tick (√) t he Suitable Option 

1. CAD stands for

a) Computer after design

b) Computer aided design

c) Computing aiding designing

d) Computer aided designer

2. Adobe Photoshop is the predominant software on the 

market

a) Music manipulation

b) Video editor

c) Photo editing and manipulation

d) Video manipulation

3. To open a file Select

a) File > New b) File > Open c) File > Cut d) File > Save

4. You can to select different tool

a) Click and hold

b) Click and save

c) Click and open

d) Click and save

5. A is simply one image stacked on top of another 

a) Channel b) Layer c) Panel d) Canvas

6. To adjust the slider for an exact amount of transparency click

a) New file b) Blend option c) Opacity d) Crop tool

7. Art board Tool (V) is

a) 

b) 

c) 

d) 

8. Photoshop's Magic Wand Tool selects areas of similar color with a single click

a) Similar image

b) Similar opacity

c) Similar size

d) Similar color

EXERCISE 
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9. Short key of Magic Wand Tool is

a) D b) W c) E d) G

10. Short key of Polygonal Lasso Tool is

a) J b) O c) P d) L

Give Short Answer to the following question 

1. What is Photoshop?

2. Write down the file formats that Photoshop allows opening.

3. What do you know about the tool panel?

4. What is a layer?

5. What is the difference between opacity and fill opacity?

6. How blend mode works? Write down its short key.

7. What is add layer mask? And how it works?

8. Why layer group is use?

9. Define smart object layer.

10. Write down the difference between Polygonal Lasso Tool and Magnetic Lasso Tool

Answer the following question in detail 

1. Enlist any 6 to 7 tools and explain them.

2. Explain the layer types.

3. Write a detailed note on the benefits and importance CAD in fashion designing.

4. What is mood board? Write down the process of creating mood board.

5. Write down the difference between layer and channel.  Make a design with the help of

pen tool and then treat that design on channel.

Final Project 

 Create a floral motif on Photoshop.

 Make its mirror and half drop repeat

 Make a color board for its color scheme.
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